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Program Overview
WinWall Plus is a program that provides various tools to manage Windows Wallpaper.    It is a 
wallpaper changer, editor, and file convertor.    

Users can gain substantial disk space by using compressed image formats, which are not 
normally usable as Windows wallpaper.    WinWall Plus includes tools that will convert images
to and from these additional formats.

Editing features include: Crop, Rotate, Resize, Stretch, and alteration of Brightness and 
Contrast.

Individual wallpapers may be positioned on the screen, and the program will "remember" 
their positions for future display.

WinWall Plus has a provision for reducing the colors in a 256-color image to 16 for VGA 
display, and for reducing True-Color (16 million colors) images to 256 (or 16) colors.

A preview function will display all of the selected wallpapers in "thumbnail" form for easy 
selection.

Multiple "queues" (configuration files) may be maintained, each saved under a distinctive 
name.



Reduce colors to 16
Reduce colors to 256
These menu options are enabled when there are more than 16 colors or more than 256 
colors, respectively, in the image displayed in the Picture Editor.    When an option is 
selected, WinWall Plus will "dither" the image to 16 or 256 colors.    There will be a loss of 
image quality, but the image will look better on lower resolution screens.



Caption Bar
The Picture Editor's caption bar will display information about the displayed image.    The 
format is NAME WIDTHxHEIGHTxCOLOR DEPTH.    During crop selection routines, the caption 
will show "crop" with the size of the selected area.



OTHER TOPICS:
Troubleshooting
Speed vs. File Size
Slide Shows
Display Order
Bitmaps
Files included with WinWall Plus
Picture Editor
Thumbnail display
Multiple wallpaper queues
Registration Info
Registration Form
Distribution of WinWall Plus
Adjusting wallpaper placement on screen
For information about controls on the main screen, choose Contents and click on the specific
control on the display.



Thumbnail Display
Small images of each of the bitmaps in your Wallpaper Queue are shown when you select 
the "View image thumbnails" option on the Images menu.    Depending on your computer 
speed and the number of images, it may take quite a while to load all of the images.    After 
loading once, subsequent displays will be much faster.    You may stop the load at any time 
by pressing the "Stop Loading" menu option (only visible while the images are loading), and 
then resume the load by pressing "Resume Loading" (only visible when the load has stopped
short of completion).    Another option available during loading is "Cancel Load" which will 
erase the preview screen.

Once the images are loaded, you can move an image to the Picture Editor by double-clicking
the image.    If you want to know the file name and path for a displayed image, press the 
mouse button down while the mouse cursor is over the image.    The window caption will 
change to display the file name.    When you select an image by clicking on it the border of 
that image will turn red.    You may then edit or delete the image with the appropriate File 
menu command.

Using the thumbnail for manual wallpaper changes:    While the thumbnail display is 
on screen, the timer is disabled and the main program window is hidden.    You can minimize 
the thumbnail display and then use it to select wallpapers.    Double-Click the thumbnail icon 
to restore the display, click once on your selection and then either use the file menu to Make
Current Wallpaper, or use the keyboard shortcut (CTRL-M).

The thumbnail file will slow some operations down, particularly wallpaper deletions.    If you 
are deleting several files in a row it is best to choose the "Clear thumbnail file" option from 
the images menu, perform your deletions, and then let the thumbnail file rebuild the next 
time you use it.

It is possible for the thumbnail display to get "out of synch" with the wallpaper queue.    If 
that happens, clear it and rebuild it.



Speed vs. File Size
There is a tradeoff between program speed and the amount of compression used on images. 
This is particularly noticeable when using the Thumbnail option.    Uncompressed .BMP files 
will display far more rapidly than the most compressed .GIF files, with .PCX between for both
speed and compression.    .TIF and .TGA are normally used for pictures containing 32,000 or 
more colors; neither offers significant compression over .BMP, and both are slower.    For 24-
bit (16-million color) images, WinWall Plus can use .JPG format, which offers great 
compression, but is very slow and will cause some loss of image quality.

On slower computers the delay when wallpaper changes occur will also be very noticeable 
with compressed files.    The decision as to which file type to use should be made according 
to the user's needs - disk space, or fast operation.

Even greater delays will occur if you use files with more colors than your computer can 
display.    WinWall Plus will convert such files to a displayable color depth, but only with a 
significant time lag.    If you are consistently using such files, you should load them into the 
picture editor and use the Edit menu to reduce the number of colors.    Then save the file 
under a new name (or overwrite the old file if you will never need the larger number of 
colors) and add it to the Wallpaper Queue.    The new image will display much faster.

There is an annoying "jump" that occurs when the wallpaper changes, which is particularly 
aggravating when working with a word processor or other heavy input-type program.    
WinWall Plus monitors the active application, and will pause the timer when the active 
application is maximized.    This is the easiest way to handle the problem, although you could
bring up WinWall Plus and turn the timer off while you are working.

Users of disk compression programs such as Stacker and MSDOS 6 DoubleSpace will find 
that there is no advantage to compressed image files (the disk compressor does a better 
and faster job), so .BMP is the correct choice.    The only exception is JPEG compression, 
which will compress more than disk compression software.



Display Order
The Display Order option in the Preferences submenu of the Wallpaper menu allows you to 
choose Random or Sequential display.    Random display will cycle through the list of 
wallpapers in no apparent order.    Sequential will display them in the order in which they are 
listed in the Wallpaper Queue.    When changing from random to sequential, the display will 
continue from the currently displayed wallpaper.    Sequential order is good for slide show 
effects.



Up and Down Buttons
Use these buttons to organize the files in a queue in a desired order (for sequential display, 
or simply to manage the files better).    The buttons will only be active when a file has been 
selected in the queue.    If the first file in a queue is selected, the Up button will not be 
active, and if the last file in a queue is selected the Down button will not be active.



List Full File Path/List File Name Only
This button controls the entries in the queue.    File Name Only will remove drive and path 
information, while Full File Path will include all directory/subdirectory information for each 
file.    In the latter case, the file name may be scrolled off to the right of the queue, making 
the entries difficult to read.    In any case, the listing for the current wallpaper will include full
path information.



Monitor Com Port
Selected from the Preferences submenu of the Wallpaper menu, this option allows you to 
select a particular com port to monitor.    If WinWall Plus detects a carrier on this port it will 
not allow the timer to cycle which otherwise might interrupt serial communications.    This 
option is intended to be used only with a port that has a modem attached.    If you use the 
option with other serial equipment such as a printer, the timer will probably not cycle 
whenever the printer is turned on.



Add Button
The "Add" Button is used to add a new wallpaper to the Wallpaper Queue.    Pressing this 
button is the same as choosing "Add Wallpaper" from the Wallpaper menu; the keyboard 
shortcut is CTRL-A.    Pressing this button will cause a dialog box to appear for browsing 
through drives and directories looking for bitmap files which can be selected for addition to 
the queue.    Files can have .BMP, .RLE,.GIF, .PCX, ,.TIF .TGA or .JPG extensions.    When the 
new bitmap is added to the queue, it will have a centered or tiled property according to the 
setting that existed at the time the Add Button was pressed.    If the desired property was not
preselected it may be changed by first clicking on the filename in the Wallpaper Queue and 
then changing the Tiling on/off Option. The image will have be positioned according to the 
setting of the default origin point.

You may add an image to the queue more than once to increase its display frequency.



Preview
Preview will give an "advance look" at a wallpaper before choosing it for editing, deletion, or 
making it the current wallpaper.    A wallpaper must be selected in the queue for this function
to be active.



Changing and Saving Queues
WinWall Plus allows multiple configuration file called "queues."    A queue file contains all of 
the default information, such as timer settings and default position origins, plus a list of the 
wallpaper files for that queue.    Wallpaper files may appear in many different queues.    When
a queue is loaded, its name will appear above the Wallpaper Queue listing.

The "Queues" selection in the Wallpaper menu has four options: "Start New Queue," 
"Change Queues," "Save Queue" and "Save Queue As."

Anytime files are added or deleted, the Queue file should be re-saved under the old or a new
name.

"Change Queues" will prompt for a .QUE file to load.    A prompt will first be issued to save 
the current configuration; if this is answered negatively, any changes since the last save will 
be lost.

Recommendation:    Establish a directory where all queue files are stored.    For example, this 
can be a directory where the wallpaper files are also kept such as \WALLPAPR, or a 
subdirectory of that directory called \QUEUES.    This makes for easier file management.



Delete Button
The "Delete" Button will be disabled (grayed) unless an entry has been selected in the 
Wallpaper Queue.    Pressing this button is the same as choosing "Delete Wallpaper" from the
Wallpaper menu; the keyboard shortcut is CTRL-D.    If a selection has been made, it will be 
deleted (CAUTION - no confirmation prompt!).    This will not delete the file from the hard 
drive, nor will it affect the current visibility of the image if it is showing on the desktop.    If 
the wallpaper is listed more than once, only the selected occurrence will be deleted



Make Current Button
The "Make Current Wallpaper" Button will be disabled (grayed) unless an entry has been 
selected in the Wallpaper Queue.    Pressing this button is the same as choosing "Make 
Current" from the Wallpaper menu; the keyboard shortcut is CTRL-M.    If a selection has 
been made, it will become the current wallpaper and display on the desktop immediately.    
The timer will not reset automatically so, if the timer is on, a new wallpaper will still be 
selected and shown when the timer cycle occurs.    If a new timer cycle is desired, turn the 
timer off and back on again.



Clear Screen Button
The "Clear Screen" button will clear any wallpaper showing from the screen.    Pressing this 
button is the same as choosing "Clear Screen" from the Wallpaper menu; the keyboard 
shortcut is CTRL-C.    Close the program or turn the timer off to keep a wallpaper from being 
displayed when the timer cycles.



Wallpaper Queue
The "Wallpaper Queue" is a list of bitmaps that are available for use by WinWall Plus as 
wallpapers.    You can show all of the images in the queue in "Thumbnail" form by choosing 
Preview all images from the Images menu.    You can add any appropriate bitmap image to 
the list via the Add Button or Import Button.    You can make a specific image occur more 
often by adding it to the queue more than once. 

You may have multiple queue lists; see Changing and Saving Queues 

For any of the following actions, you must first select a wallpaper in the queue.    This means 
that you must click once on a file name, then perform the action.

Delete Button.    
Tiling on/off 
Make Current Wallpaper Button.    
Position Wallpaper 
Edit Button.



Change Delay
The box to the left of the caption "Minutes delay between changes" may be directly edited.    
Allowable times are 0.1 to 999.9 minutes.    A delay of 5-30 minutes is suggested - there is a 
noticeable jump-delay on the screen when the wallpaper is changed, and this can be 
annoying if the timer cycles too frequently.    On the other hand, when the computer is not 
being used, a short time interval may be used to produce a "Slide-Show" effect.

This setting will have no effect if the Timer switch is not on.

Changing the delay time will cause the timer to reset (if it is on) and the "Minutes to next 
change" will become the new setting.

Timing will not be precise when other Windows processes are in progress.



Timer on/off
The "Timer on off" switch determines whether the wallpaper will change at the interval set in
the "Minutes delay between changes" box.    The switch will retain its setting between 
sessions of the program.    You may wish to turn the timer off if you are working on a project 
where you would be annoyed by the screen "flicker" that occurs during a wallpaper change; 
you can accomplish much the same thing by simply maximizing the program with which you
are working.    Turning the timer off and then on again will reset the timer, and the "Minutes 
to next change" field will revert to the timer interval.



Minutes to next change
This field will display the time, in tenths of a minute, until the next scheduled wallpaper 
change.    The field is blank when the timer is turned off.    Countdown is suspended when the
active application occupies the full screen (Maximized), which generally includes 
screensaver activity.



Tiling on/off Option
Wallpapers may be displayed either Tiled or not.    The Tiling Off option means that the 
wallpaper will be shown once in the center of the screen or alternatively starting at another 
point (see Adjusting wallpaper placement on screen).    With Tiling on, wallpaper that is 
smaller than the screen size will be shown in multiple images to fill the entire screen.    The 
position of this switch when a new wallpaper is added to the queue will determine the initial 
setting for that wallpaper.    To change a wallpaper's setting, select it in the queue and then 
change the switch.



Registration

Don Bradner
Arcata Pet
600 F Street
Arcata,CA 95521
WinWall Plus 1.3 copyright 1993 by Don Bradner.    WinWall Plus is Shareware.    Please 
register WinWall Plus by filling in the Registration Form and sending it with $15.00 to the 
author at the above address.    You will receive a copy of the most recent version of WinWall 
Plus and a registration key that will eliminate the startup screen for this and all future 
versions of WinWall Plus.    Some high-resolution photographic images in .GIF format will also 
be included.    You will also receive mail notification of major upgrades to WinWall Plus, which
you may order for a nominal amount if you cannot find a BBS to download them from.    Your 
registration and comments are appreciated.    Please address comments/suggestions to the 
above address or to the author on Compuserve at 76130,1007.

Commercial use:    WinWall Plus may be used commercially, as long as there is a registered
copy for each computer/terminal that is using it.    The author is willing to discuss 
customization of the program for commercial/large scale application, including use as 
presentation software.



Current Wallpaper
The Current Wallpaper area at the bottom of the WinWall Plus screen displays the complete 
path for the currently displayed bitmap.    If there is no wallpaper displayed, the listing will be
"(None)"



Edit Image
The "Edit" Button will be disabled (grayed) unless you have previously selected an entry in 
the Wallpaper Queue.    Pressing this button is the same as choosing "Edit Image" from the 
Image menu; the keyboard shortcut is CTRL-E.    Clicking this button will open the Picture 
Editor with the selected entry displayed, ready to edit.



Picture Editor
The Picture Editor is a major feature of WinWall Plus.    You can access the Picture Editor by 
selecting a file in the Wallpaper Queue. and pressing the Edit Button.    You can also access 
the Editor from the Thumbnail Display by double clicking on a displayed image.    When the 
image is displayed, you may edit it in a variety of ways.    Choose an option below to learn 
more about the use of editing features.

Caption information

Edit Options:
Resize
Resize to 640x480
Resize to 800x600
Resize to 1024x768
Stretch
Crop
Rotate
Mirror
Brightness & Contrast
Reduce colors to 16
Reduce colors to 256
Copy
Paste

File Options:
New
Save
SaveAs
Add to Wallpaper Queue



Add to Wallpaper Queue
Add to Wallpaper Queue in the File Menu will add a listing for the current image in the 
Picture Editor.    to the WallpaperQueue.    You will only be able to add images in these image 
types: .BMP, .GIF, .PCX, ,.TIF .TGA and .JPG.

You may add an image more than once to increase its display frequency.



Copy
The copy option in the Picture Editor's Edit menu will copy a displayed image to the Windows
Clipboard, where it can be pasted into other applications.



Paste
The Paste option in the Picture Editors Edit menu will only be active (not greyed) when the 
Windows Clipboard contains an image that can be read by this program.    The pasted image 
will replace any image already displayed; a prompt will be issued to save the current image 
if it has been altered.



Load File dialog box
The Load file dialog is shown when the Add button or Import button is clicked, as well as 
from the New menu option in the picture editor.    You may browse through your directories to
find any image file which WinWall recognizes.    A handy preview function is included.    Select
a file and click the Preview button.    A small "thumbnail" version of the file will appear in the 
box above the button.    When you have found an image that you wish to load, click OK.    To 
exit the dialog without making a selection, click Cancel.    If you change directories and then 
load a file, that directory will be the one shown the next time you add a file.

Checking the "Add all files in directory" checkbox will cause the program to add any and all 
files in the selected directory which have proper bitmap extensions.    You will still need to 
select a file before you press the OK button, which is a limitation of the Windows Common 
Dialog; the selection you make will be ignored.    This option is not available if the Add 
function originated from the thumbnail view.

Recommendation:    Establish a \WALLPAPR directory for your images to make for easier file 
management.



Save As dialog box
The Save As dialog is shown when a file is Imported, when Save As is chosen in the picture 
editor, and when Save is chosen in the picture editor but the file is not of a type that can be 
saved by WinWall Plus.    You may use the dialog to change the name and/or the file 
extension.    Note that the file extension is governed by the option selection at the lower 
right of the screen.    If you name a file "MYFILE.BMP" and select .GIF as the extension, the 
file will be saved as "MYFILE.GIF" and the type will be .GIF.    WinWall Plus does not 
understand files with extensions and types which do not agree.    When you choose a file 
type, you may check the "Make Default" checkbox and that extension will be the one 
showing the next time you use the dialog.    If you change directories, the new directory will 
be the one showing the next time you use the dialog.

Recommendation:    Establish a \WALLPAPR directory for your images to make for easier file 
management.



Resize
This menu option will allow you to resize an image in the Picture Editor.    You will see a dialog
box with various options.    If you want to resize an image to 80% of its original size, input 0.8
in the Scale box.    To resize 125%, enter 1.25.    You may enter a new width and/or height 
directly - if the Proportional Resize checkbox is checked, the other dimension will also 
change to keep the same proportions.    Otherwise, the image will stretch to accommodate 
the new width or height.

The Preview button allows you to see the effect of your selection without changing the 
underlying image.    The OK button will alter the image to match the new settings.    Cancel 
restores the unaltered image.



Resize to 640x480
Operates the same as Resize except that the dimensions are fixed for a VGA screen.    This 
function always produces an image proportional to the original, which means that if the ratio
of the original's width-to-height is less than 1.33 the produced width will be less than 640, 
and if the ratio is greater than 1.33 the produced height will be less than 480.



Resize to 800x600
Operates the same as Resize except that the dimensions are fixed for an SVGA screen.    This
function always produces an image proportional to the original, which means that if the ratio
of the original's width-to-height is less than 1.33 the produced width will be less than 800, 
and if the ratio is greater than 1.33 the produced height will be less than 600.



Resize to 1024x768
Operates the same as Resize except that the dimensions are fixed for a 1024x768 (8514-
type) screen.    This function always produces an image proportional to the original, which 
means that if the ratio of the original's width-to-height is less than 1.33 the produced width 
will be less than 1024, and if the ratio is greater than 1.33 the produced height will be less 
than 768.



Stretch
Stretch is also called "Free Resize."    When this option is selected, the mouse cursor will 
change to a four-arrow configuration.    You can then "grab" any side or corner of an image 
and drag it to a new size.    When you release the mouse button, the image will be stretched 
or compressed to fit the new window size.    When you have finished resizing, select the Edit 
menu again and re-select Stretch to accept the changes or select Undo Stretch to discard 
your changes.

For resizing to specific dimensions, use the Resize option in the Edit Menu.



Crop
Crop allows you to select an area of an image displayed in the Picture Editor.    Make your 
selection by moving the mouse cursor to a starting corner of the area desired.    Press and 
hold the mouse button down, "sweeping" over the selected area.    An outline box will display
the chosen area, and the Picture Editor top caption bar will display the size of the area 
chosen (in pixels).    When the cropping selection is completed, release the mouse button.    If
a different selection is desired, repeat the above steps; the first selection will be erased as 
the new selection is begun.

If the region you have selected is not quite right, you may choose to adjust the selected 
area.    See Adjusting Crop Boudaries

When you have a selection that you wish to use, select Crop from the Edit Menu.    The 
window frame will shrink to match your selection.



Adjusting Crop Boundaries
Whenever there is an active cropping region, there will be an active entry in the Edit menu 
of the Picture Editor for "adjusting crop boundaries."    Selecting this option will show a form 
to enter new offsets for left, right, top, and bottom borders of the cropping region.    You may 
directly enter new numbers, and the "rubber band" area in the editor will dynamically 
change to reflect the new settings.    Choose OK to accept the changes or Cancel to restore 
the original cropping region.



Rotate
The Rotation submenu has options to rotate an image in 90 degree increments left or right 
(counter-clockwise or clockwise) as well as 180 degrees.    Rotating 180 degrees is not the 
same as Mirror Vertical, which changes the orientation of the image.    Rotating 90 degrees
4 times in the same direction will restore the original image.



Mirror
There are two mirror choices in the Edit Menu.    Mirror Horizontal will flip the image 
displayed in the Picture Editor left-to-right.    Mirror Vertical will flip the image top-to-
bottom.



Brightness & Contrast
The Brightness & Contrast controls allow some alteration of these characteristics of an 
image displayed in the Picture Editor.    When this option is selected from the Edit Menu, 
two slide bars will appear at the bottom of the editor as well as Accept and Reject buttons.    
Sliding the top control will affect the image's brightness, while the second bar will affect 
contrast.    Using the two together will have various effects, which will be immediately visible
when the mouse button is released.    When editing is completed to your satisfaction, press 
the Accept button, or if you feel that the original image is preferable, Reject the edited 
version in favor of the original.



New
New in the File Menu allows you to place a new image in the Picture Editor, replacing the 
existing image.    You are not limited to the list of wallpapers in the Wallpaper Queue; any 
valid image may be loaded in any format recognized by WinWall Plus:    .BMP, .RLE,.GIF,
.PCX,, .TIF .TGA or .JPG.



Save
Save in the File Menu will save the image that is currently displayed in the Picture Editor,as
long as the image is in a format which WinWall Plus can write:    .BMP,.GIF, .PCX, .TIF, TGA or
.JPG. .RLE can be loaded but not saved.    If you try to save an image in a format which 
WinWall Plus cannot write, you will be prompted to use Save As instead.



Save As
Save As in the File Menu is used to change the name, directory, or file type of an image in 
the Picture Editor.    You will only be able to save in the wallpaper types, .BMP,.GIF, .PCX,, .TIF
.TGA or .JPG.



Import Wallpaper
The "Import" Button is used to add a new wallpaper to the Wallpaper Queue and change the 
format at the same time.    Pressing this button is the same as choosing "Import Wallpaper" 
from the Wallpaper menu; the keyboard shortcut is CTRL-I.    Pressing this button will cause a
dialog box to appear which will allow you to browse through your directories looking for 
bitmap files which you can select to add to the queue.    Files may have .BMP, .RLE,.GIF,
.PCX,, .TIF .TGA or .JPG extensions.    Another dialog box will prompt you for a filename and 
extension to save the file as, limited to the same extensions.

If you are viewing your wallpaper on a screen with fewer colors than the image contains, you
will probably want to reduce the color depth.    After adding the image to the queue, load it 
into the Picture Editor and select Edit/Reduce colors to 16. or Edit/Reduce colors to 256, 
whichever is appropriate.

If you want to add a file without changing its name or extension use the Add Button.    When 
the new bitmap is added to the queue, it will have a tiling property according to the setting 
that existed at the time the Import Button was pressed.    If you did not pre-select the desired
property, you may change it by first clicking on the filename in the Wallpaper Queue and 
then changing the Tiling on/off Option.



Wallpaper Menu
The Wallpaper menu duplicates the various buttons in the WinWall Plus interface, making it 
easy to use the functions from the keyboard, and has additional functions as well.    Using the
Alt-W key combination will pop up the wallpaper menu, and then you may select an option 
by pressing the letter underlined in that option or using the arrow keys to move to the 
option.    Most options also have "hotkey" combinations that are shown to the right of the 
option.    For example, holding down the control key and pressing 'A' will have the same 
results as selecting "Add Wallpaper."

The wallpaper menu also includes selections to manipulate queues.



Preferences
This menu contains items that affect the way WinWall Plus works.    It allows you to change a 
number of defaults to customize the program to your own liking.    Click any of the topics 
below to get information on that topic.

Change Wallpaper at Startup
Special 'Change Wallpaper' Icon
Display Order
Set Default Origins
Monitor Com Port



Change Wallpaper at Start
By default, WinWall Plus does not change your wallpaper when the program is started.    If 
you want it to do so, check this option.    If WinWall Plus is in your Program Manager Startup 
Group, you will get a new wallpaper whenever you start a Windows session.



Special 'Change Wallpaper' Icon
This option, found under the Preferences sub-menu of the Wallpaper menu, allows manual 
wallpaper changes without having to bring up the main WinWall Plus screen.    Checking this 
option means that when the program is minimized the regular icon will not show.    Instead 
there will be a small form that may be clicked to produce a wallpaper change.    This option 
has no effect if you have chosen to hide the program icon.

Double clicking the form will bring the main WinWall Plus screen back.    Whenever the small 
form is active (the top caption will be highlighted), pressing the spacebar will cause a 
wallpaper change.    If the timer is active it will be reset when the wallpaper changes.

Default location for the form is the bottom right-hand corner of the screen.    If you move the 
form by dragging the caption, WinWall Plus will "remember" the form's location and use it 
until you change it again.

This option makes it easy to use WinWall Plus for narrated "Slide Shows."    Turn off the timer 
and set the Display Order to Sequential.    Select the last image in the queue and press the 
"Make Current Wallpaper" button.    Then press the "Clear Screen" button and minimize the 
program.    Now when you press the spacebar the first image in the queue will be displayed 
and each press of the spacebar will bring up the next image.



Set Default Origins
This item in the Preferences sub-menu sets the default location for each newly added 
wallpaper image.    You may change the individual setting later - see Adjusting wallpaper 
placement on screen



Images Menu
The Images menu has two options: Edit Image, and Preview All Images.    Edit Image will only
be enabled if a selection has been made in the Wallpaper Queue, and will load the Picture 
Editor.    Preview All Images will load small sketches of each image for viewing/editing (see 
Thumbnail Display)



Help Menu
The Help Menu provides two options: Help, which will run the file you are now reading, and 
About, which provides current version information for WinWall Plus.



.BMP
Files with .BMP extensions are bitmapped images created by tools like Windows Paintbrush.   
.BMP is the native format for Windows wallpaper.    There are a few .BMP files distributed with
Windows specifically for use as wallpaper.



.GIF

.GIF, pronounced "Jiff" is a format developed by Compuserve Information Services.    It 
provides the most compression possible without loss of image quality.    It is the format of 
choice for images distributed through on-line services and BBS services, since it reduces the 
time necessary to transmit.    Storing your wallpapers as .GIF files will use the least amount 
of space, and WinWall Plus will take care of converting the format for Windows as required.    
Because this conversion takes a small amount of time, it could result in an unacceptable 
delay on slower computers.



.PCX

.PCX is a format developed by the Z-Soft corporation for their line of PC Paintbrush 
programs.    Windows Paintbrush is also able to read and save this format.    It provides some 
compression when compared to .BMP files, but not as much as a .GIF.    Like .GIF, .PCX can 
not be used as a native wallpaper format, but WinWall Plus will take care of the translation.    
There is less noticeable delay when using .PCX than with .GIF.



.TGA

.TGA is called "Targa."    It is primarily a format for storing 24-bit (true-color) 16-million color 
images.    WinWall Plus can read the format, and use it as a wallpaper, but there is no space 
advantage and it will load slower than .BMP.    If you have a Targa image that you would like 
to use, Import it and save it in .BMP format (or convert it to .GIF if it has 256 colors or less).



.TIF

.TIF is the extension used with Tagged Information File Format (TIFF) files    It is primarily a 
format for storing 24-bit (true-color) 16-million color images and grey-scale images in 
desktop publishing.    WinWall Plus can read the format, and use it as a wallpaper, but there 
is no space advantage and it will load slower than .BMP.    If you have a Tiff image that you 
would like to use, Import it and save it in .BMP format (or convert it to .GIF if it has 256 
colors or less).    Tiff files may contain more than one picture.    If that is the case, WinWall 
Plus will only read the first image.    An exception is the .TIF file used to store WinWall Plus's 
own Thumbnail files.



.JPG
Files with .JPG extensions are "JPEG" compressed.    JPEG stands for Joint Photographic 
Experts Committee.    This format is only suitable for 24-bit (16-million color) images, and is 
"lossy," which means that the compression involves some loss of quality.    The resulting file 
size is quite small, but takes a long time to decompress and display.    When saving an image
in the JPEG format you may select a quality factor from 5 to 95; the higher the number, the 
less compression and greater quality.    There is no particular speed advantage to any of the 
settings.



.RLE
Files with .RLE extensions are compressed bitmap images.    RLE stands for "Run-Length 
Encoded."    RLE files may have an extension of .RLE or .BMP, however the .RLE extension 
avoids confusion as to whether the file is compressed.    Windows has no problem using .RLE 
files as wallpaper, but Windows Paintbrush will not load or create them, nor can WinWall Plus
save a file in this format.    A third-party tool must be used.



Wallpaper
Wallpaper is the term used to describe an image being displayed on the Windows desktop as
a background.    It can be a small image that is repeated many times, or a single image of 
any size up to the full screen size.



The Author



Bitmaps
A bitmap is an image stored as a pattern of dots.    These images can be stored in a number 
of graphics formats, but the only formats which can be used as wallpaper directly by 
Windows are .BMP and .RLE.    With WinWall Plus, you may use .GIF, .PCX, .BMP, .TIF, .TGA 
and .JPG as wallpaper, and the program will interpret the files as necessary for use by 
Windows.

Where to get bitmaps
Several .BMP files are included with Windows for use as wallpaper.    Additionally, you can 
draw your own bitmaps with Windows Paintbrush.    If you have a scanner, you can scan 
images and store them as bitmaps.    Many computer stores and printing businesses offer 
custom scanning to order.    On-line services have thousands of files which can be used as 
wallpaper.    Most of these files will be in .GIF or .PCX format, which cannot directly be used 
as wallpaper except with this program or another of its type.

A new option for obtaining images is via Kodak Photo CD.    You can take slides, negative, 
prints or undeveloped film to a Kodak dealer and have them converted to high-resolution 
images on CD-ROM.    To use these images, you will need a Photo-CD compatible CD-ROM 
drive for your computer, and software capable of reading the Kodak format and exporting it 
in .BMP or .PCX form.    One example of this is Kodak Photo CD Access, a $39.95 (list) 
program available from Kodak and many software dealers.    For more information, contact a 
Kodak dealer.    If you do not get all of the answers you need, ask for Kodak's 800 number.    
Once you have exported the image, you can use WinWall Plus to resize and edit the image 
for use.



Files
Several files make up the complete WinWall Plus package.    A brief discussion of each 
follows:

Files included with WinWall Plus
In the distribution package, most of the following files will have their last letter 
replaced with an underscore (_).    This indicates that they are compressed files, 
which are expanded by the setup program.

WWPLUS.EXE This is the program file.    It can be placed in any directory and can be added 
to any of your program groups as an icon.    For normal operation it is recommended that the
icon be added to your Startup Group, so that it automatically runs whenever you run 
Windows.

WWPLUS.HLP The WinWall Plus help file which you are reading now.    For the program's 
help function to work, this file should be located in your Windows directory.

CTL3DV2.DLL
IMK.DLL
JPEGIO.DLL
KNIFE.VBX
MHCM200.VBX
MHCOMD.VBX
MHRUN300.DLL
WWPLUS.DLL
These are "custom-control" libraries that WinWall Plus uses for some of its functions.    These 
files must be in your Windows\System directory for proper operation of WinWall Plus.

SETUP.EXE
SETUPWWP.EXE
VER.DLL
These files are used by the Setup program, which installs WinWall Plus.

README.TXT A text file explaining the nature, installation, and operation of WinWall Plus.
HISTORY.TXT A text file that describes the changes made to WinWall Plus with each 
release.
FORMATS.TXT A text file explaining each of the graphics formats, with the pros and cons of
using each.

These text files are included with WinWall Plus, but are not installed on your hard drive.

Registered users will have one additional file: WWP_REG.KEY.    This file must be in your 
Windows directory, and will keep the startup shareware screen from appearing.    If you 
upgrade to a new version of WinWall Plus, do not delete this file - it will work with all future 
versions.

Files maybe included with WinWall Plus
VBRUN300.DLL A "runtime" library for programs written in Visual Basic 3.0.    This file is not
always included when the program is obtained from a BBS or other on-line source, since it is 
relatively large and you only need one copy.    You can obtain the file from many on-line 



sources that carry Windows files or from Microsoft.    On BBS and other on-line systems, look 
for VBRUN300.ZIP or VBRUN3.ZIP (you will need PKUNZIP to extract the .DLL from the .ZIP 
file).    If you received WinWall Plus on disk from a shareware service, the runtime is normally 
included.    If not, please notify the service that they are not distributing the program in a 
usable form.    If WinWall Plus was obtained from the author, VBRUN300.DLL was included.    
This file should be placed in your Windows\System directory.

Image files.    There may be images included with WinWall Plus if it was obtained on a disk.   
These are usually in an \images subdirectory, and may be accompanied by a RIGHTS.TXT file
that sets forth usage restrictions.

Files not included with WinWall Plus
COMMDLG.DLL The "common dialog" library is included with Windows 3.1 and should be in
your Windows\System library.    Without it, you will not be able to use the Add Button to add 
bitmaps to your Wallpaper Queue.

Files created by WinWall Plus
All of the following are in your Windows directory and should not be moved.

WWPLUS.INI    This data file holds a list of the images that you have selected as wallpapers,
as well as all of your program settings.

WWPLUS.BMP    This is a "temporary" file that WinWall Plus uses to translate non-standard 
images so that they can be used by Windows.    It is destroyed and recreated each time the 
wallpaper changes unless the new image is a .BMP file.

WWPLUS.TIF    This is a multiple image file that is used to speed the display of thumbnail 
images.

WinWall Plus also creates some other temporary files with .TMP extensions.    Under normal 
use, the program will clean these up when it exits.    If the program crashes, it will clean 
them up the next time it is run and then exited normally.



About this screen:
This is a normal working screen.    The Program Manager is placed in the left 1/3 of the 
screen, leaving the rest of the desktop for wallpaper.    The wallpaper image shown is an 
original photograph belonging to the author, scanned and then converted to wallpaper.



Distribution
WinWall Plus is shareware and may be freely distributed as long as all of the files are 
included and no fee is charged beyond a reasonable fee for distribution.    Registered users
note:    Do not distribute your WWP_REG.KEY file.

All rights are reserved by the author (see Registration).



Troubleshooting
If your difficulties are related to slow operations with specific images, see Speed vs. File Size

If you receive a Windows message that a "SUB OR FUNCTION NOT DEFINED," it normally 
indicates that you have an older version of a file used by WinWall Plus located in the path 
ahead of the version installed by WinWall Plus.    The most likely culprit is MUSCLE.VBX, a file 
used by many programs.    WinWall Plus uses functions that are not in early versions of the 
program.    Look in your Windows and Windows\System directories for duplicate copies 
of .DLL and .VBX files; delete older copies.    WinWall Plus generally installs MUSCLE in the 
Windows\System directory; an earlier copy in the Windows directory will definitely cause 
problems.    Programs which needed the earlier version should not have problems, since the 
file is backwards compatible.

Other difficulties running the program may be associated with a missing file, or a file that 
needs to be in the Windows or Windows\System directory but isn't.    See Files for details.    
Another problem is a corrupted WWPLUS.INI file.    It is sometimes possible to fix a corrupted 
file; if you are an experienced Windows user and regularly alter .INI files, you may want to 
load WWPLUS.INI into Notepad and see if anything is obviously bad.    If you are not 
comfortable with this, or cannot determine the problem, rename the file (it is in your 
Windows directory) to WWPLUS.OLD and restart the program.    This will not delete any of 
your wallpapers, but you will have to re-add them to your Wallpaper Queue.    If the program 
now runs correctly, and you do not want to completely rebuild all of your settings, you can 
compare the contents of the newly created WWPLUS.INI with the old file and look for bad 
settings in the old file.    If you can correct them, you can rename the .OLD file back to .INI 
and go on from there.

A user has recently reported getting a General Fault that crashed his Windows completely to 
the point of having to reboot.    It turned out that one of his wallpaper files was corrupted 
(not related to WinWall Plus), and would also crash if he tried to load it into Windows 
Paintbrush.    Deleting the file from the queue solved the problem.

There is a specific Windows bug that causes Windows to fail if a wallpaper with more than 
256 colors is loaded when a 256 color display is in use.    WinWall Plus will not let you do this 
- it changes the file to 256 colors before displaying it.    However, if you are running a display 
at more than 256 colors (such as 32K, 64K or 16 million colors), the wallpaper can have that 
many colors.    If you then change display drivers to 256 colors, Windows will crash and not 
load.    If this happens, you have two options.    You can run setup from the DOS prompt 
within your Windows directory and change to a 16 color driver or a true color driver, and 
reload Windows.    Clear the wallpaper and then proceed to change to the 256 color driver.    
Alternatively you may use the DOS Edit function to edit your WIN.INI file and delete the 
wallpaper file reference.    It is best to avoid this situation by always using the "Clear Screen" 
function before changing display drivers.



Using WinWall Plus to create presentation 
Slide Shows
WinWall Plus can easily be used to make continuously cycling slide shows by setting a short 
display interval and then minimizing your Program Manager and any other running 
programs.    Setting the Display Order to Sequential will allow you to establish the order in 
which the images are displayed.    If you intend to use the program in this fashion, you may 
wish to keep the order in mind as you add new images to the Wallpaper Queue.    The 
thumbnail view can help you see the "slides" as they will be shown.    Using this feature in 
conjunction with the ability to setup different queues can make for interesting self-running 
displays.    See Changing and Saving Queues.

You can manually cycle a slide show by using the "Special 'Change Wallpaper' Icon" option in
the Preferences sub-menu of the Wallpaper menu.



Adjusting wallpaper placement on screen
Changing the wallpaper's location
By default, there are only two ways to display a wallpaper in Windows: Tiled, or 
single/centered.    Tiled wallpapers are repeated as necessary to cover all of the screen 
background.    With tiling off, wallpapers are displayed just once on the screen, normally in 
the center.    If the Wallpaper is the same size as the screen, Tiled or not will look exactly the 
same.    Winwall Plus makes it possible to change the location of a non-tiled wallpaper by 
setting the wallpaper origin (upper left corner position).

The screen above shows an image with an origin 231 pixels to the right (X) and 88 pixels 
from the top (Y) of the VGA screen (640x480).

Setting the wallpaper origin

For all of the following, remember that a setting of 0 (zero) for X or Y coordinates will center 
a wallpaper on that axis.    You cannot set the upper left corner of a wallpaper to 0,0; use 1,1 
instead.

First, you should select a default origin that will be used if a specific origin is not selected for 
a wallpaper.    Click the Wallpaper menu on the main program screen, click Preferences, and 
then click Set Default Origins.    A dialog box will prompt you for settings and take care of the
details.    The next wallpaper change will incorporate the new settings, unless there is a 
specific origin for that wallpaper.

To select a specific origin for a wallpaper, you may directly position the wallpaper, or you 
may change the settings. In either case, first select the file in the Wallpaper Queue.    You 
may then choose Position Wallpaper in the Wallpaper menu.    The program screen will be 
replaced by the image, which you may move by pressing and holding down your left mouse 
button.    When you have the image positioned where you want it, release the mouse button. 
Double-Click on the image or press the Enter key to "fix" the placement.    Press the escape 
key to exit without setting a new position.    Alternatively, you may enter the numbers 
directly in the X and Y coordinate boxes after selecting the file in the queue.    If either of the 
coordinates end up being zero, the box will read "centered" to remind you that it is not a 
true zero.
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Version 1.357

Send this form with $15 to:
Don Bradner
Arcata Pet
600 F Street
Arcata, CA 95521

Name:                 __________________________________________
Mailing Address:      __________________________________________
                      __________________________________________
City & State:         __________________________________________
Phone number (Optional) (______)______________________
If you wish, you may pay with a credit card:�
Card type:  VISA    MasterCard   AMEX    Discover� � � �

Card Number:  ___________________________________
Expiration Date: _________________
Signature to authorize charge: _______________________________
Circle disk size wanted (3-1/2 is default):   5-1/4    3-1/2
Please help the author by answering the following (optional):
Where did you get WinWall Plus?
BBS or other on-line service.  Which one?_____________________�
Software Service.  Which one? _______________________________�
Friend�
Other _________________________________________�

Tell me what you like about WinWall Plus:
_______________________________________________________
_______________________________________________________
Tell me what you would like me to add or change in WinWall Plus:
_______________________________________________________
_______________________________________________________



Hiding the program icon
While WinWall Plus is running an icon will normally be displayed at the bottom of your 
screen.    Once you have made all of the wallpaper selections that you desire, you may "turn 
off" the icon by selecting that option.    The icon on the program screen will change ('Xed'-
out).    The program icon will not be visible, and the program will not show up in the Task 
Manager list.    If you need to change something in the program, go to your startup group (or 
whatever group the program is installed in) and double-click the icon.    This will not run a 
new copy of the program, rather the existing copy will become visible.




